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Overview

The following guide describes the standard processing steps for processing ppk data collected
by the E400 without ground control points (GCPs) in Agisoft Metashape Profession edition.

Requirements

1) Imagery from flight
2) Geotags for imagery
3) Agisoft metascan professional

Adding photos for standard cameras

Select the Add photos command from the Workflow menu.

Browse the source folder and select files to be processed then click ok. The images will be
added to the cameras tab.
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Adding photos for multispectral cameras

If working with a RGB camera skip to the importing references section of this manual. Open the
Workflow menu and choose the Add Photos option. Select all images including reflectance
calibration images and click the OK button. In the Add Photos dialog choose Multi-camera

system option:

Add Photos

Flease select data layout:

Single cameras

S Multi-camera system

Lok J Cancel ]

If the images are stored in several folders, the same operation should be repeated for each
folder.

Reflectance calibration (for multispectral cameras only)

Agisoft will automatically detect reflectance calibration images taken before and after flight.

Agisoft Metashape

i Calibration images were moved to separate folder.

Open Tools menu and choose the Calibrate Reflectance option. Press Locate Panels button:
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Calibrate Reflectance

Images Panel Calibration
Label Panel . Band Leflectance
1 EBElue
2 Green
3 Red
4 Red edge

5 NIR

Parameters

renectance paneis L=e sun sensor

Reset oK

As a result, the images with the panel will be moved to a separate folder and the masks would
be applied to cover everything on the images except the panel itself. If you are using the panel
for the first time, and its calibration is not added to Metashape Pro internal database yet, you will
be prompted to load a calibration from a CSV file:

Agisoft Metashape

? Missing calibration for panel: RP04-1826266-5C. Do you want to load it now?

If you don't have a CSV file with calibration information, you can input calibration values
manually at the next step. If you own MicaSense radiometric panel, you can request the
corresponding CSV file from MicaSense directly: https://www.micasense.com/prv

After the panels are located, the reflectance values corresponding to each band should be input
according to the panel certificate.
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Calibrate Reflectance X

Images Panel Calibration
Label Panel . Band Reflectance
HZ IMG_0000_1... RP04-1826266-5C (5/5) 1 Blue 0.51
HZ IMG_0001_1... RP04-1826266-5C (5/5) 3 Green 0.51
HZ IMG_0002_1... RP04-1826266-5C (5/5)
3 Red 0.509
4 Red edge 0.509
5 NMIR 0.508
Parameters
Use reflectance panels IUse sun sensor

Reset Cancel

Run reflectance calibration (for multispectral cameras only)

Check on Use reflectance panels and Use sun sensor options in the Calibrate Reflectance

dialog to perform calibration based on panel data and/or image meta information. Click OK to

start the calibration process.
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Importing references

To import the camera coordinate data from the CSV file, click the Import Reference button on
the Reference pane. Browse to the file containing recorded reference coordinates and click the

Open button.

Reference

D“‘o_ !iII

Import CSV
Coordinate System
WGS 84 (EPSG::4326)

Rotation angles: Yaw, Pitch, Roll
Ignore labels Threshold {m}:
Delimiter Columns
Tab Label: 1 Accuracy
Semicolon ) -
Longitude: 3 8
Comma
Latitude: 2 8
Space
Other: Altitude: 4 8
Combine consecutive delimiters
Startimport atrow: 1
First 20 lines preview:
. Label Latitude Longitude Altitude
1 275.jpg 41.03901672 -81.53502224 356.856
2 274.jpg 41,03871073 -81.53502788 355.6757
3 273.jpg 41.03842006 -81.53503035 355.0086
4 272.jpg 41,03813867 -81.53503826 355.8031
5 27.jpg 41.0378734 -81.53504847 354.8554
[ ok |

Rotation
Yaw: 12
Pitch: 10
Roll: 13
Enabled flag:
Items:

Accuracy
q
q
q

All

In the Import CSV dialog, set the parameters for import (coordinate system, delimiter, columns,

etc.)
Geotagging method | Latitude Longitude Altitude
PPK Dependant on base Dependant on base Dependant on base
coordinate coordinate coordinate
Companion WGS84 WGS84 MSL
Computer
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Setting Geotag Accuracy

Reference

Click the reference settings tab.

Reference Settings

Coordinate System
WES 84 (EP5G:4326)

Camera reference

o

WG5S 84 (EP5G::432

Marker reference

o

WG5S 84 (EP5G::432

Rotation angles:

Measurement Accuracy

Camera accuracy (m): 10
Camera accuracy (deg): 10
Marker accuracy {m): 0.005
Scale bar accuracy (m): 0,001

Miscellaneous

Capture distance (m):

[

Yaw, Pitch, Roll

Image Coordinates Accuracy

Marl?er accuracy (pix): 0.5

Tie point accuracy (pix): 1

Change the Camera accuracy based on your geotag accuracy.

Geotagging method | Accuracy

PPK .05m

Standard Accuracy 5m
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Camera Calibration

Select Camera Calibration from the Tools menu.

Camera Calibration & X
ILCE-6100, E 20mm F2.8 Camera type: Frame
ST AR 0.004 ¥ 0.004
Focal length (mm): 20

I +// Enable rolling shutter compensation I Film camera with fiducial marks

Iniial  Adjusted  Bands = GPS/INS Offset
Reference Accuracy Adjusted Variance
X (m): 0 0.05
' {m): 0 0,05
I Z (m): 143 0.01| I

Yaw (%): 0 2

Pitch (°): 0 2

Roll (%): 0O 2

/' Enable reference Adjust GPS/INS offset

Camera label Resclution Camera model  Focal length Date & time

Mo G000 A000 ILCE-E100 20 2019:06:12 17:20002 I

- 60004000 ILCE-6100 20 2019:06:12 17:34:08

M 0 G000 A000 ILCE-6100 20 2019:06:12 17:34:27

M 100 G000 A000 ILCE-6100 20 2019:06:12 17:38:31

Mo G000 A000 ILCE-E100 20 2019:06:72 17:38:33
[ C R N ANNN I CF-100 n 019:06:17 17:38:34

Event 38 Unmanned Systems, Inc

Cancel

9/24



Select the following settings depending on your camera.

A6100

Rolling shutter Enabled
PPK Z offset (m) 143
PPK Z accuracy .001
RX1RII

Rolling shutter Disabled
PPK Z offset (m) 1529
PPK Z accuracy .001
ATR IV

Rolling shutter Disabled
PPK Z offset (m) 149
PPK Z accuracy .001
Altum-PT

Rolling shutter Disabled
PPK Z offset (m) 113
PPK Z accuracy .001
RedEdge-P

Rolling shutter Disabled
PPK Z offset (m) 144
PPK Z accuracy .001
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Align Photos

Select the Align Photos command from the Workflow menu.

Set the parameters in the Align Photos dialog window:

Align Photos

General

Accuracy: High

Generic preselection

Reference preselection Source
Reset current alignment
Advanced
Key point limit: 40,000
Tie point limit: 10,000
Apply masks to: lone

Exclude stationary tie paints
Guided image matching

Adaptive camera model fitting

Lok ] Cancel

Click the OK button. The progress dialog box will appear displaying the current processing
status. To cancel the processing, click the Cancel button.
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Alignment having been completed, computed camera positions, and a sparse point cloud will be
displayed in the Model view.

Perspective 30° Snap: Axis, 30

faces: 22,840,096 vertices: 11,424,456
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Optimize camera locations

Click the Optimize toolbar button on the Reference pane.

Reference

5w o mnne

In the Optimize Camera Alignment dialog box, check additional camera parameters to be
optimized.

Optimize Camera Alignment

General
it F Fit o, cy
Fit ki Fitpl
Fitk2 Fit p2
Fit k3 Fitbl
Fit kg Fitb2
Advanced

Adaptive camera model fitting
Estimate tie point covariance

Fit additional corrections

Click the OK button to start optimization.
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Build Dense Cloud

1. Select Build Dense Cloud command from the Workflow menu.

2. In the Build Dense Cloud dialog box select the desired reconstruction parameters and click
the OK button.

Build Dense Cloud

General

Quality: High
Advanced
Depth filtering: Mild
Reuze depth maps

Calculate point colors

Calculate point confidence

L_oc ) Cancel

The progress dialog box will appear displaying the current processing status. To cancel the

processing, click on the Cancel button.
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Build DEM

Select the Build DEM command from the Workflow menu.

Buid DEM

Projection

Type: Geographic Flanar Cylindrical

WG5S 84 (EPSG::4326)

Parameters

Source data: Tie points
Quality:
Interpolation: Enabled (default)

Point dasses: Al Select...

Advanced
Region
Setup boundaries:  -51.539869 - | -81.522872 ¥
Reset 41.031064 - | 41042312 Y
Resolution {m): 0.867776

Total size (pix): 1647 ® 1439

oc _J cancel ]

In the Build DEM dialog box, set your required parameters.

Click the OK button. The progress dialog box will appear displaying the current processing
status. To cancel processing, click the Cancel button.
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Build Orthomosaic

Select the Build Orthomosaic command from the Workflow menu.

Set parameters in the Orthomosaic dialog window.

Buid Orthomosaic
Projection

Type: ® Geographic

WG5S 84 (EPSG::4326)

Parameters

Surface:

Blending mode:
Refine seamlines
Enable hole filling
Enable ghosting filter

Enable badk-face culling

Planar Cylindrical

DEM

Mosaic (default)

©  Pixel size (%): 1.2937e-07
| Metres... | 8.758322-08
Max. dimension (pix): 4096
Region
Setup boundaries:  &.521930 - | 8.531367
Estimate 47.548633 — | 47555543
Total size (pix): 72559 ¥ 7389
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3. Click the OK button. The progress dialog box will appear displaying the current processing
status. To cancel the processing, click the Cancel button.
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Calculating required index information (for multispectral cameras only)

Use the Set Raster Transform option from the Tools menu to open the Raster Calculator dialog.

On the Transform tab specify the index values that you would like to calculate from the source
data.

Raster Calculator X

Transform  Palette

Input Bands: Output Bands:

B1 - Blue 1 (85-83)/ (85 +B3) v @
B2 - Green 2 25%(B5-B3)/(B5 +2.4*B3+1) v ®
B3 - Red 3 B5+0.5- (0.5 *sqrt((2 *B5 + 1)~2 -8 * (B5 - (2 *B3)))| v

B4 - Red edge

B5 - MIR

B5 - LWIR

- - 1 s 1 o B o
IR BV BT T TR
o 1 -~ ] oo ] @& ] ot

Enable transform

Cancel

More than one formula can be input, if it is necessary to export the orthomosaic with several
output bands related to the different indices, or if the calculated indices should be represented in
false colors mode.

On the Palette tab select how one of the calculated indices should be visualized or use False
Colors representation for three output bands (note that for this approach the values of the output
bands used should be in 0 - 1 range for proper RGB representation, the values would be
automatically scaled to 8-bit RGB representation in False Colors mode).

The following picture shows the representation of the single output band defined on the
Transform tab (B1 in this case). The color representation of the index can be selected from the
list of presets, loaded from *.clr file or modified manually, if necessary.
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Range values under the histogram define the absolute values for the selected index (output
band), the color values from the palette section will be scaled to the selected range in the
following way: Min. Range value corresponds to the 0 value in the palette color scale and Max.
Range value corresponds to 1 value of the color palette:

Raster Calculator X

Transform  Palette

B T o

. °
[ Jo
[ ]oa
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1
1
1
1
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0.2 0 0.2 0.4 0.6 0.8

-1
Cancel

5

./ Interpolate colors

When the False Colors option is selected the histogram area can be ignored. It is only
necessary to select the correspondence between the output bands and RGB colors in the False
Colors mode:
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Raster Calculator

Transform  Palette

0.00 1"::':' Useband: E1
|
|
[ B False Color
|
|
|
| .
|
|
| [ 2
|
| -
|
|
|
|
|
|
|
|
|
|
|
|
|
i
0.3 0.2 0 0.2 0.4 0.6 1
Range: 0O -1 Auto +/  Interpolate colors
i Apply
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Exporting the results

Select Export DEM command from the File menu.

In the Export DEM dialog, specify the desired coordinate system for DEM export. Check Write

KML file and/or Write World file options to create files needed to georeference the orthomosaic

in the Google Earth and/or a GIS-application, if necessary.

RGB camera example settings

Multispectral example settings

Export DEM - TIFF
Coordinate System

WGS 84 (EPSG::4326)

Image description:

Compression

Write tled TIFF

Max. dimension (pix):

Raster
Pixel size (): 4, 28848e-07
[ metres... | 3.247162-07

Splitin blocks (pix): 10000 X 10000
Raster transform: None
No-data value: 32767
Region

Setup boundaries: #1.538559 -81.524154
41.0322 41.041050
Total size (pix): 33824 x 27253

Clip to boundary shapes

Write KML file Write World file

Write tile scheme
Metadata

Write BigTIFF file

Export Orthomosaic
Coordinate System
WGS 84 (EPSG::4326)

Raster
Pixel size (%): 6.76925e-07 X
4.69237e-07 ¥
Max. dimension (pix): 4096
Split in blocks (pix): 1024 ¥ 1024
I Raster transform: Index value I
Background color: White

Region
Setup boundaries:
Reset
Total size {pix):
Write KML file
Write tle scheme
Compression
Image description:
TIFF compression:
IPEG quality:

Write BigTIFF file

10888 x 9215

Write World fille

Lzw

90

Write tiled TIFF

Generate TIFF overviews

Write alpha channel

Generate TIFF overviews

Click the Export button to start the export.
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Browse the destination folder, choose the file type, and print in the file name. Click the Save
button.

The progress dialog box will appear displaying the current processing status. To cancel the
processing, click the Cancel button.

Export Orthomosaic

Select Export Orthomosaic command from the File menu.

2. In the Export Orthomosaic dialog box specify the coordinate system for the Orthomosaic to
be saved in.

Export Orthomosaic - TIFF
Coordinate System

WGS 34 (EPSG::4326)

Raster

Pixel size (%): 2.14424e-07 X
[ wvetres... | 162358207 ¥
Max. dimension (pix): 409
Splitin blocks {pix): 10000 x | 10000
Raster transform: one
Background color: White

Region

Setup boundaries: 81

————— v
Total size {pix): 50081 x 34563
Wirite KML file Write World file

Write tile scheme

Metadata

Image description:

Compression
TIFF compression: LZw
JPEG quality: 90
Write tiled TIFF Write BigTIFF file

Generate TIFF overviews

Save alpha channel

Click the Export button to start the export.

Browse the destination folder, choose the file type, and print in the file name. Click the Save
button.

Event 38 Unmanned Systems, Inc 23/24



The progress dialog box will appear displaying the current processing status. To cancel the
processing, click the Cancel button.
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